Welcome to BitZipper

Welcome to the next generation ZIP utility BitZipper from Bitberry Software.

Bitberry Software will be specialising in aggressively priced, feature packed, high quality consumer products. Our
goal is to challenge some of the major players in the business with what we believe to be better products priced more
reasonably.

Key benefits of BitZipper include:

100% nag free. The evaluation version works exactly as the registered version. No registration reminder messages
are displayed, and it does not connect to the Internet to download commercials or upload personal information of
any kind. You may try it 30 times before deciding if you want to register.

Easy and intuitive interfaces. Advanced users may use the "standard" interface, while the rest of us may prefer the
simpler Wizard interfaces.

Powerful Batch Tool that enables you to extract, test, virus scan, search and convert many archives in one
operation.

"Skinable" toolbar - change the look of the program as you wish.
Instant help everywhere in the program by clicking the ? button.

Supports more archive formats than any other zip utility. Creates 8 different types of archives, and extracts files
from 15 different archive types. And that is not counting uuencoding, xxencoding and the 7 self-extracting archive
formats supported.

Archive folder tree eases archive content browsing by providing a Windows Explorer-like interface for archives. You
will soon wonder why all other ZIP utilities haven't implemented this feature a long time ago!

Easy backups using Backup Sets. You can create an unlimited number of backup sets that basically holds
information about which files and folders you want to add to an archive. These archive definition can be used over
and over again, allowing you to backup e.g. documents, images and other personal files almost by the click of a
button.

Option to create self extracting archives of 7 (seven!) types included free. Competitors charge as much as US $49
for this feature alone!

Extensive Windows Explorer integration. You can compress and uncompress files by clicking on the filenames in
the Windows Explorer, you can add files to an archive by dragging them onto an existing archive, you can extract
files from an open archive by dragging the file from the archive to a folder and you can Zip and E-mai with a single
click from within the Windows Explorer!

Advanced search feature allowing you to search for files with specific content within an archive.
Save file list as ASCII, comma separated text, HTML, Microsoft Word, Microsoft Excel or XML

BitZipper Explorer is a build-in Windows Explorer-like navigator accessible from the main window of BitZipper -
there is no longer any need for an "Open file" window when opening archives.

Convenient user interface. All relevant windows can be resized. Don't you just hate those tiny, fixed sized
windows? Also, the most used windows of BitZipper remember their position and size on the desktop and are
displayed the same way the next time you use the program, and the Extract window remembers the most recently
used folders. Further, all Open and Save As dialogs contain a drive selector, folder tree and file list for convenient
navigation.

Multiple open archives are handled by having a tab for each open file. Simply click the tab with the name of the
archive you want to work with and the content is displayed instantly.

Cheap investment. A single user license of BitZipper costs the modest price of $25 (USD) only.



* + all the "standard" ZIP utility features such as virus scanning, software installation, testing archives for errors,
converting to other archive formats, archives spanning multiple disks, view archive comments, use your favourite
viewer to view files within an archive, password protected archives and much more.

We hope you will enjoy working with BitZipper.



About this help file

Various layouts are used in this help file:

[Ctrl-X] This indicates a keyboard shortcut. This example shows that you must hold down the Ctrl key and press the
X key.

This color refers to a visible text in a window on either a checkbox or a button which you must click.

This color indicates a link to another topic in the help file. You can click it to jump to the topic automatically (except in
this example).

This color indicates something that you must pay special attention to.



BitZipper on the Web

Get the latest news and updates from the Bitberry Software web site at www.bitzipper.com.

We welcome your feedback! We would love to hear about your experiences with BitZipper, good or bad. Let us know

how you feel at feedback@bitberry.com.

Do you have an idea for a new feature you would like to see in BitZipper? Send a description to
suggest@bitberry.com - the best suggestions will be rewarded with free lifetime licenses of BitZipper!



Competitive comparisation
This comparison covers BitZipper 2.0 and WinZip 8.0 final. If you have comments to the chart below, do not hesitate
to contact us.

Feature BitZipper 2.0 WinZip 8.0
Extract archive formats (note 1) 15 8
Create archive formats (note 1) 8 1
Decode e-mail formats 2 6

SFX archive formats 7 0 (note 2)
Export file list formats 6 0
Batch operations Yes No
Archive tree view Yes No

Extract/drag a specific folder from an archive Yes No

Add files to new/specific folder in an archive Yes No

Zip and Unzip Wizards Yes Yes
Easy Backups Yes No
Skinable toolbar Yes No
Multiple open archives Yes No
Search for files in archives Yes No
Virus scanning Yes Yes
Automatic software installation Yes Yes
Convert archive format Yes No
Online help on every item in the user interface Yes No
Drag & Drop support Yes Yes
Windows Explorer integration Yes Yes
Run files in archive Yes Yes
View files in archive Yes Yes
Open MRU list Yes Yes
Extract MRU list Yes No
Test archive for errors Yes Yes
Single-user license US $25 Us $29

1) Formats supported without requiring 3rd party programs.
2) Separate product that creates only Zip SFXs and costs US $49.



About Bitberry Software
Bitberry Software is a privately held company located in the Kingdom of Denmark. The company was formally
founded in year 2000, but the work on our first product, BitZipper, has been ongoing for more than a year prior to this.

The owner of the company has a background as professional developer of communications and billing software used
by some of the largest ISPs and telecommunication companies in the world, and the many years of experience
writing bullet proof, mission critical software is reflected in the products of Bitberry Software.

Bitberry Software will be specializing in aggressively priced, feature packed, high quality consumer products. Our
goal is to challenge some of the major players in the business with what we believe to be better products priced more
reasonably.

Contact addresses

Bitberry Software
Skolegade 35
DK-4300 Holbaek
Denmark

Phone: +45 5945 1888 (not for ordering or support)

sales@bitberry.com - Sales questions
beta@bitberry.com - For signing up as beta tester
support@bitberry.com - Support questions

feedback@bitberry.com - General feedback
webmaster@bitberry.com - Issues regarding our web site



What is an archive?
What is an archive?

An archive is simply a collection of files stored in a single file. Nothing more, nothing less.

There are different types of archives. Basically the functionality is exactly the same, you store several files in a single
archive file. The difference is in the way the files are compressed. Different compression algorithms are used to

create the different archive types. You can recognize the different archive types on the filename extension (the letters
after the last dot).

What is a self-extracting (SFX) archive?

A self-extracting archive is an archive created as an executable file. This means that the receiver of the archive does

not have to have a zip utility to extract files from it, he simply runs the archive file and is asked to select which files to
extract.

What are the benefits of using archives?

When you store documents and other types of files on your harddrive they are not optimized for size. Usually
software vendors store them in a format that is fast to read, but on the other hand takes up a lot of space on your
harddrive. Storing files in archives have several benefits:

¢ |f you have files you rarely use, you may save a lot of space in your harddrive by compressing them into an

archive. BitZipper lets you view the files within the archive by a single click of a button, so it does not involve a lot
of extra work for you.

* Easier file maintenace as you have a single archive file instead of maybe hundreds of small files.

Faster transmission of files over the Internet. Send the files faster, especially relevant if you or the recipient pays
for online time when dialling the Internet to send or receive files.

Which archive formats are supported?
BitZipper can create 8 (eight!) different archive formats:

.bh - BlakHole archive

.cab- Microsoft Cabinet

.gz - Unix GZ (gz/tar)

Jar - JavaSoft archive

Jha - Lha archive

Azh - Lzh archive

.tar - Unix tape archive

.zip - Zip archive, the most common format used today.

and that's not counting the 7 different self-extracting archive formats!
Further, BitZipper can extract 15 (fifteen!) different archive formats:

.ace- Ace archive

.arc - Alexa archive

.arj - Arj archive

.bh - BlakHole archive
.cab- Microsoft Cabinet
.gz - Unix GZ (gz/tar)
Jar - JavaSoft archive
.Iha - Lha archive

zh - Lzh archive

.rar - Rar archive



.tar - Unix tape archive

.tgz - Unix Tar/GZ archives

.z - Unix Compress archives
.Zip - Zip archive

.Z00- Zoo archive

+ the 7 different self-extracting archive formats ofcourse...



How to create an archive
Creating an archive using the standard interface

You must perform 4 to 5 simple steps to create an archive:

® Click the New button on the toolbar, select New archive from the File menu or simply press [Ctrl+N]. This will
display the New archive window.

® Select a folder to store the archive in by using the drive selector and folder tree, just as you select a folder in
Windows Explorer.

* Enter the archive name in the "Save as:" input field. If this name contains drive and folder information, it will
override the selections in the drive selector and folder tree. Do not yet enter the name of the files you wish to add
to the archive, that is done later.

* Optionally check the Show Add dialog to immediately start adding files to the archive.

® Click the OK button.

This will display an empty archive on the main window and you are now ready to add files to it.

You are also able to create archives using the Wizard interface, the Windows Explorer interface and the Drag and
Drop interface.




How to open an archive
Opening an archive using the standard interface

This operation requires three simple steps:

® Click the Open icon on the toolbar, select Open archive from the File menu or simply press [Ctrl+O]. This will
display the Open archive window. The default open folder may be specified in the Preferences entry under the Edit
menu.

® Find the archive using the Windows Explorer-like window.

* Double-click the file or click the Open button.

You may enter the name of an archive directly in the File name input field if you know the name and location. Further,
you may limit the number of archives displayed by filtering names using wildcards, e.g. entering "a*.zip" will only
display zip archives starting with the letter a in the selected folder.



How to add files
Adding files to an archive using the standard interface

This operation requires that you have already opened an archive. You must perform at least 3 steps to add files to an
archive:

Click the Add button on the toolbar, select Add from the Edit menu or simply press [Ctrl+A]. This will display the

Add files window.

Find the folder containing the files to add to the archive using the drive selector, folder tree and folder content list.
Select the files to add by selecting either one or more files or folders.

Those are the main steps needed to add files to an archive. There are some general settings that you may or may not
want to change:

Optionally change the suggested Files option to specify that all, selected or user defined files should be added.
Optionally fill in the Store in folder field to store the files in a new folder in the archive.

Optionally change the Compression setting. There are four options: None, Light, Normal and Maximum. Maximum
takes the longest time to compress, but on the other hand also gives the best compression result.

Optionally set the Folders options. If Include files in subfolders is checked, files in folders below the current folder is
added as well. If Include folder information is checked, folder information is stored in the archive so that the same
folder structure may be created when extracting the files. If Include drive information is checked, drive information
is stored in the archive so that the files may be extracted to the same drives when extracting the files. If Relative
folders is checked, it means that the folder names will begin at the current folder, and not contain the full path as on
your system - this means that the folder tree from the current folder and below will be stored, not the structure
above the current folder.

Further, by clicking the Advanced tab you get access to specifying more options:

If Delete files after adding is checked, the files will be deleted from your harddrive when they have been added to
the archive. Use this feature with great caution.

You may specify behaviour based on file attributes. If Only add if archive bit is set is checked, only files with the
archive bit set will be added to the archive. If Clear archive bit after adding is checked, the archive bit will be
removed from the files after adding them to the archive.

You may specify a Password to encrypt the content of the archive. It is important that you remember the password
as it must be used when you later want to extract files from the archive. There is no way to recover a lost password
other than trying all password combinations.

You may specify a list of filenames and filespecs never to include in archives. This feature is most commonly used
to avoid adding backup files and other temporary files to archives.

You are also able to add files to archives using the Wizard interface, the Windows Explorer interface and the Drag
and Drop interface.




How to view files
Viewing files using the standard interface

This operation requires that you have already opened an archive. You must perform two simple steps:

® Select the file(s) to view by selecting them in the content list
® Click the View icon on the toolbar or select View selected files from the View menu, or simply press [Ctrl+V].

This will display the file(s) using the viewer associated with the file. To run the program associated with the file simply
double-click the file in the content list.



How to run files
Running files using the standard interface

This operation requires that you have already opened an archive. You must perform one simple step:
® Simply double-click a file to run it.

Double-clicking a file will extract it and if it is an executable file it will be run directly, otherwise the program associated
with the file type will be run. If you for example double-click an HTML file your default web browser will be started to
display the file.



How to extract files
Extracting files using the standard interface

This operation requires that you have already opened an archive. You must perform 3 to 5 simple steps:

Click the Extract button on the toolbar, select Extract from the Edit menu or simply press [Ctrl+X]. This will display
the Extract window.

Select a folder to extract the files to by using the drive selector and drive tree, just as you select a folder in
Windows Explorer. You may enter a folder name directly in the "Save in:" input field. If the folder entered does not
exists it will be created. Optionally you can create a new folder by clicking the New folder icon.

Optionally select which files to be extracted in the Files box. By default this is set depending on which files were
selected in the content list when clicking the Extract button. All files is default if no files were selected, otherwise
Selected files will be default. You may enter a filename or filespec to extract as well.

Optionally set the extract Options. Select whether to be prompted before overwriting existing files, if file attributes
should be maintained, if folders should be created and if you want to launch the Windows Explorer after extraction.
The settings will be saved for future extract operations.

Click the Extract button to extract the files.

This will extract the selected files to the selected folder. If you have checked "Create original folders" the folders
stored in the archive will be created below the selected destination folder.

You are also able to extract files from an archive using the Wizard interface, the Windows Explorer interface and the
Drag and Drop interface.

Tip: If the archive contains a setup program you may press the Install icon on the toolbar to extract all files from the
archive and run the setup program. When the setup program is finished the files will be cleaned up.



How to delete files

Deleting files using the standard interface
This operation requires that you have already opened an archive. You must perform four simple steps:

® Select the file(s) to delete by selecting them in the content list
® Click the Delete icon on the toolbar, select Delete from the Edit menu, or simply press the Del button on the

keyboard. This will display the Delete files window.
* Choose if you want to delete the selected files, all files (the entire archive) or enter a filename or filespec to delete.

® Click the Delete button.

This will delete the files from the archive, or delete the archive itself. If the archive is deleted, it is actually moved to
the Recycle Bin.



How to create a Backup Set
Creating a Backup Set using the standard interface

You must perform 5-6 really simple steps to create a new Backup Set:

Select Configure backup sets from the Backup menu.

Enter the name of the backup set

Enter the default folder to store your backups in.

Choose if you want to add files stored in sub-folders

Add files to the backup set by clicking the Add button or by using the Drag and Drop interface
Click Save set

You are now ready to perform backups of the selected files almost by the click of a button!



How to perform a backup
Performing a backup using the standard interface

You must perform 4 really simple steps to perform a backup:

® Click the Backup button on the toolbar, select Backup files from the Backup menu or simply press [Ctrl+B]. This
will display the backup window.

® Select the Backup Set you wish to use

* Enter the backup archive name in the "Save as:" input field or click the "..." button to browse your system for the
destination folder and file name.

® Optionally enter a password used to protect your new archive

® Click the Backup button.

That's it! You are also able to perform backups using the Wizard interface.



Menu tree
Detailed descripton of the main menu

The main menu is the menu at the top of the main window.
It contains the following items:

File - Contains actions related to entire archives.

Edit - Contains actions related to files in archives + program preferences.
View - Contains actions related to files in archives and program layout.
Tools - Contains special actions that can be performed on archives.
Backup - Contains actions related to easy backups.

Help - Contains links to help, licensing and registration information.

Click one of the links above to get help on a specific menu.



File menu
The File menu contains actions related to entire archives.

New archive [Ctrl-N]
Creates a new archive on hardisk or floppy disk.

Open archive [Ctrl-O]
Opens an archive and displays the archive content in the work space.

Close archive [CtrI-C]
Closes the current archive.

Move archive
Moves the current archive to another folder on the disk.

Copy archive
Copies the current archive to another folder on the disk.

Rename archive [Ctrl-R]
Renames the current archive.

Delete archive [Ctrl-D]
Deletes the current archive.

Mail archive [Ctrl-Alt-M]
Starts your deault mail program and opens a message with the archive as attachment.

Print [Ctrl-P]
Prints the content list of the current archive.

Export [Ctrl-E]
Exports the content list of the current archive to text, CSV, XML, HTML, Microsoft Excel or Microsoft Word format.

Exit
Stops BitZipper.



Edit menu
The Edit menu Contains actions related to files in archives + program preferences.

Add [Ins]
Adds files to the current archive.

Extract [Ctrl-X]
Extracts files from the current archive, either all, by selection or by filespec.

Delete [Del]
Deletes files from the current archive, either by selection or by filespec.

Search [Ctrl-S]
Searches files in the current archive for a text string or a decimal, hexadecimal or octal byte sequence.

Run [Ctrl-Alt-R]
Runs the selected files from the current archive.

Select all [Ctrl-L]
Selects all files in the current archive.

Invert selection [Ctrl-I]
Inverses the selection of files in the current archive (all selected files are deseleted, and all deselected files are
selected).

Preferences [Ctrl-Alt-P]
Opens the Preferences window, letting you customise program behaviour and layout.



View menu
The View menu contains actions related to files in archives and program layout.

View selected file(s) [Ctrl-V]
Views the content of the selected files in the current archive.

Toolbar [Ctrl-Alt-T]
Displays or hides the toolbar below the menu.

BitZipper Explorer [Ctrl-Alt-E]
Displays or hides the BitZipper Explorer to the left of the archive content list.

Language
Displays the a submenu with the available languages. Select one and the interface is translated immediately.



Tools menu
The Tools menu contains special actions that can be performed on archives.

Wizards [Ctrl-W]
Starts the easy-to-use BitZipper Wizard interface.

Batch Tool [Ctri-Alt-B]
Starts the BitZipper Batch Tool, enabling you to work with multiple archives at once.

Test archive [Ctrl-T]
Tests the archive content for checksum errors.

Make .exe file [Ctrl-Alt-M]
Converts the current archive into a self-extracting executable archive.

Convert [Ctrl-Alt-C]
Converts the current archive into another archive format.

UUEncode [Ctrl-U]
UU-encodes the current archive for non-binary transfers.

Install [Ctrl-Alt-I]
Installs the program in the current archive without you having to extract the files first. Only possible if the archive
contains a setup.exe file.

Virus Scan [Ctrl-Alt-V]
Checks the archive content for virus using an external anti-virus package.



Backup menu
The Backup menu contains actions related to easy backups.

Backup files [Ctrl-B]
Backs up files using the easy backup feature.

Configure backup sets
Configures backup sets for later easy backups.



Help menu
The Help menu contains links to help, licensing and registration information.

Contents [F1]
Displays the contents of the help file.

Search for help on...
Searches for help by keywords entered by the user.

How to use help
Displays information on how to use the Windows help system.

Frequently asked questions
Displays a list of frequently asked questions about BitZipper.

Ordering information
Displays information about ordering and prices.

License agreement
Displays the end-user license agreement.

Enter registration code
Lets the user enter a registration code received after paying the registration fee.

About BitZipper
Displays information about the program author and registration information.



The toolbar

The toolbar is the list of icons displayed under the menu and is used for quick access to commonly used functions.
The same functions may be accessed through the menu or keyboard shortcuts.

You can configure which functions to include in the toolbar in the Preferences window, which you can activate from
the Edit menu.



What is a Wizard?

A Wizard is a helper application that makes performing complex tasks easier. A Wizard has a simple decision in a
window, which has Back and Next buttons underneath. When you have filled in the required data, you click the Next
button to go to the next window, or you can click the Back button to change your previous decision.

BitZipper has 4 Wizards:

1) Create new archive

2) Extract or install files from an existing archive
3) Create new backup set

4) Backup files using existing backup set

You may access the Wizard by clicking the Wizard button on the toolbar or by selecting Wizards from the View menu.




Create new archive Wizard
Creating an archive using the Wizard interface

You must perform 4 simple steps to create an archive using the Wizard interface:

® Click the Create new archive checkbox and click Next.

* Enter the name of your new archive and/or browse your system for the destination folder, and click Next.

® Select the files to include in your archive either by pressing the Add button to browse your system for them, or by
dragging files or folders from the Windows Explorer and dropping them on the filelist. Then click Next.

® Click Close.

That's it, your archive has now been created.



Extract files Wizard

Extract or install files from an existing archive using the Wizard interface

You must perform 4 simple steps to extract or install files from an archive using the Wizard interface:

Click the Extract or install files from an existing archive checkbox and click Next.

Enter the name of your archive or browse your system for it and click Next.

Enter the destination folder name or browse your system for it. Check the Explore files after extracting checkbox to
start the Windows Explorer after extracting files, or optionally check the Run setup program and clean up after
extracting to automatically install the program in the archive (only valid if a setup.exe file is included in the archive).
Then click Next.

Click Close.

Your files have now been extracted to the folder you specified.



Create new backup set Wizard
Create new backup set using the Wizard interface

You must perform 4 simple steps to create a new backup set using the Wizard interface:

® Click the Create new backup set checkbox and click Next.

* Enter the name of your new backup set and click Next.

® Select the files to include in your backup set either by pressing the Add button to browse your system for them, or
by dragging files or folders from the Windows Explorer and dropping them on the filelist. Then click Next.

® Click Close.

You have now created a backup set which you can use later to backup the same folders again and again by the click
of a few buttons. It doesn't get much easier than this!



Backup files Wizard

Backup files using the Wizard interface
You must perform 4 simple steps to create backup using the Wizard interface:

Click the Backup files using existing backup set checkbox and click Next.

Select the backup set to use and click Next.
Enter the name of your new backup archive and/or browse your system for the destination folder, and click Next.

Click Close.

You have now backed up your data. The created archive should be stored on an external media like CD-ROM, DVD
or tape for optimal safety.



What is Windows Explorer?

The Windows Explorer is the Windows application you use to browse your system for files and folders. It is activated
by right-clicking the Start menu normally available in the lower left corner of the taskbar on your screen. Choose
Explore in the menu that pops up to start the Windows Explorer.

BitZipper integrates with Windows Explorer (this is also called shell integration) by adding new features to the
standard Windows features of the Windows Explorer. The new features are available when right-clicking a file or
folder.

See also Add files to an archive, Extract files from an archive and Compress and e-mail a file.



Add files to an archive

The BitZipper Windows Explorer integration gives you 4 new options to add files to archives. Access the new features
by right-clicking a non-archive file or folder and select the BitZipper menu. The options are:

1) Add to... Select this option to specify name and location of an archive to add the file to.

2) Add to x:\archivename.zip Select this option to create a new archive with the same name as the file and add the
files to it.

3) Add to x:\TEMP\untitled.zip Select this option to add the files to an archive called untitled.zip in the Windows
temporary folder.

4) Zip and e-mail Select this option to create an archive with the same name as the file. Your default e-mail client is
started, and the new archive is attached to the new message ready to be sent.



Extract files from an archive
The BitZipper Windows Explorer integration gives you 4 new options to extract files from archives. Access the new
features by right-clicking an archive file and select the BitZipper menu. The options are:

1) Extract to... Select this option to specify where to extract the files in the archive to.

2) Extract to x:\foldername\ Select this option to create a folder with the same name as the archive and extract the
files to it.

3) Extract to x\TEMP\ Select this option to extract the files to the Windows temporary folder.

4) Convert to .exe file Select this option to convert the archive to a self extracting archive.



Compress and e-mail a file
The BitZipper Windows Explorer integration allows you to zip and e-mail a file in a single operation.

Simply right-click a non-archive file or folder and select Zip and e-mail from the BitZipper menu. This will create an
archive with the same name as the file and launch your default e-mail client, attaching the new archive to a new blank
e-mail ready for you to send.



What is Drag and Drop?

Drag and Drop is a technology for moving files and folders. In the Windows Explorer you activate a file or folder drag
by clicking a file/folder holding down the left or right mouse button while moving the mouse. You will see the mouse
cursor change, and the name of the file/folder is displayed next to it. If you move the mouse cursor over another

folder, or in this case the BitZipper main window, and release the mouse button, the file/folder is copied to this
location.



Opening an archive
You may open an archive using drag and drop by selecting it in the Windows Explorer holding down the left or right
mouse button, and move the mouse cursor over the BitZipper main window and release the button.

If no other archive is open in BitZipper, either button works similar. If another archive is open and you use the left
mouse button, the dragged archive will be added to the already open archive. If you use the right mouse button, a
popup menu is displayed when you release the mouse button, allowing you to select whether to add the file to the
active archive or to open it in another window.



Adding files to an archive

You may add files and folders to an open archive using drag and drop by selecting the files/folders in the Windows
Explorer holding down the left or right mouse button, and move the mouse cursor over the BitZipper main window
and release the button. You must have opened the archive to add the files to prior to doing this.

If you drag your selection using the left mouse button, the files/folders are added immediately. If you use the right
mouse button, a popup menu is displayed allowing you to add the files immediately, display the standard Add Files
window to select more files or to cancel the operation.



Extracting files from an archive
You may extract files from an archive using drag and drop by selecting the files in the archive content list, holding
down your left mouse button and moving the mouse cursor over the location you want to extract the files to, e.g. a

folder in Windows Explorer or on the Desktop. Release the mouse button to extract the files.



Frequently Asked Questions

The following is a list of frequently asked questions and their answers.

How do I... questions:

1) How to | create a new archive? Read the answer here.

2) How do | open an archive? Read the answer here.

3) How do | extract files from an archive? Read the answer here.

4) How to | add files to an existing archive? Read the answer here.

5) How do | view files from an archive without extracting them first? Read the answer here.
6) How do | run files from an archive without extracting them first? Read the answer here.
7) How do | delete files from an archive? Read the answer here.

8) How do | create a Backup Set? Read the answer here.

9) How do | perform a backup? Read the answer here.

What is... questions:

1) What is an archive? Read the answer here.

2) What is the Windows Explorer? Read the answer here.
3) What is Drag and Drop? Read the answer here.

4) What is a Wizard? Read the answer here.

Other questions:
1) How do | order BitZipper and what does it cost? Ordering information is here.
2) How do | contact Customer Support? Read the answer here.

3) Where do | find the BitZipper Software License Agreement? It is right here.



Technical support
Technical support is included in the standard license fee at no extra cost.

Help is available everywhere in BitZipper by clicking the ? icon in the upper right corner of the active window. Click it
and click anywhere in the window to get help on that specifc item.

Also consult the list of frequently asked questions and their answers in the EA.Q. section of this help file.

You are also welcome to send an e-mail to support@bitberry.com or by postal mail to Bitberry Software, P.O.Box 171,
DK-4300 Holbaek, Denmark.

When reporting a problem make sure to include the following information:

1) When and how did you see the problem?

2) Can you reproduce the problem and how?

3) Which version of BitZipper are you running? Get the version number from the About BitZipper entry in the Help
menu.

4) Which version of Windows are you running (95, 98, NT 4, 2000 etc.)?

5) If you see an error message, please include the full text of the error message or eventually a screenshot.



Software License Agreement
BitZipper end user license agreement

Last updated January 10th, 2001

PREFACE

You must carefully read the following terms and conditions before using this software. All use of the BitZipper
software is subject to this license agreement, unless you have a different license agreement with Bitberry Software.
By clicking the Yes button below, you are agreeing to be bound by all terms and conditions of this agreement and you
consent to be bound by and become a party to this agreement. If you do not agree to all terms and conditions of this
agreement, you must press the No button which will stop the installation procedure, and you will not have a license to
use any part of the BitZipper software.

Bitberry Software may revise the End User License Agreement from time to time without notice by posting a hew
version of the document on the Bitberry Software web site at http://www.bitberry.com. You should consult the most
current version of this document to ensure your activities conform to the most recent version.

UNREGISTERED VERSION

The unregistered evaluation version of BitZipper may be distributed freely in its original, unmodified format. You may
not repackage the software or in other ways change the setup program or any other files. You are free to include the
BitZipper installation files on CD-ROMs or any other media providing that you do NOT charge the end-users for the
software, and that you send a notification to distrib@bitberry.com describing when and how you wish to distribute the
software.

REGISTERED VERSION

By using the BitZipper Software ("BitZipper") you agree to abide by the terms of this license agreement
("Agreement"), Subject to the terms of this Agreement, Bitberry Software hereby grants you a limited, personal,
nontransferable, nonsublicensable license to use BitZipper.

One registered copy of BitZipper may be installed on computers used by one single person only, or it may be installed
on one workstation used nonsimultaneously by several persons, but not both.

A registered copy of BitZipper may be accessed through a network, provided that you have obtained an individual
license for all workstations that will access the software through the network. Each workstation must have an
individual license, regardless of whether they use BitZipper concurrently or not.

You may copy BitZipper for archival purposes only. The registered version may NOT be distributed to other people
than the license owner.

RESTRICTIONS

You agree you will not attempt to reverse engineer, modify, translate, create derivative works of, or disassemble
BitZipper in whole or in part or to otherwise attempt to derive source code or underlying ideas or algorithms from
BitZipper. You may not remove any proprietary notices or labels from BitZipper.

DISCLAIMER OF WARRENTY - Covers all versions

BitZipper and any support or services you may receive from Bitberry Software, its suppliers, licensors and affiliates
are provided "AS IS" without warranties of any kind. Bitberry Software hereby disclaims all express or implied
warranties, including without limitation warranties of merchantability, performance or fitness for a particular purpose.
Further, there is no warranty for the optional virus scanning feature as BitZipper makes use of third party virus
scanners.

Neither Bitberry Software or its suppliers, licensors or affiliates warrants that licensee will have continuous,



uninterrupted use of the software or that BitZipper is error free. Any program must be thoroughly tested before relying
on it, and the user must assume the entire risk of using this program.

LIMITATION OF LIABILITY

Bitberry Software and its licensors, suppliers and affiliates shall NOT be liable under any tort, contract, strict liability or
other legal or equitable theory for any indirect, special incidential or consequential damages of ANY kind including,
without limitation, damages for lost profit, loss of goodwill, work stoppage, computer failure or malfunction, or any and
all other commercial damages or losses. In NO event will Bitberry Software, its licensors, suppliers or affiliates be
liable for any damages in excess of the list price for a license to use BitZipper, even if Bitberry Software, its licensors,
suppliers or affiliates have been informed of the possibility of such damages.

TERMINATION

This Agreement, including all of your rights to use BitZipper, will terminate automatically and immediately if you fail to
comply with the terms and conditions of this Agreement. On termination you must destroy all copies of BitZipper.



Ordering information
You are able to order BitZipper online using your credit card on a secure server, or by telephone, fax or mail order.
For more information see www.bitzipper.com/order.html.

One registered copy of BitZipper may be installed on computers used by one single person only, or it may be installed
on one workstation used nonsimultaneously by several persons, but not both.

Copies Price per copy
1 Us $25

2-9 us $20

10-24 US $15

25-49 us $12

50-99 US $8

100-199 US $6

200-499 US $5

500-999 us $4

1000- US $3.5

Inquiries about discounts and other sales related questions should be mailed to sales@bitberry.com.



Display parent folder

Press this button to display the content of the parent folder. This is the same as clicking the folder above the current folder in the
tree above.



Folder content

This window contains a list of files in the selected folder. To open an archive, either double-click the file or drag it to the workspace of
BitZipper.



Drive structure

This window displays the layout of folders on your system as a tree. Click on the small + signs to display sub-folders. Clicking on a
folder name will display the files in the folder in the list below this window.



Drive selector

Select a drive, virtual or physical, from this selector, and the content will be displayed in the tree- and list views below.



Create new folder

Click this button to create a new folder. Enter the name of the new folder in the input field that appears and press Enter to create
your new folder.



BitZipper Explorer splitter

A splitter is an item that splits a window in two. It is a thin line between the explorer tree and explorer list. Hold down the left mouse
button when the cursor is above the splitter, and move the mouse up or down to resize the two splitter panes.



Workspace splitter

A splitter is an item that splits a window in two. It is a thin line between the BitZipper Explorer and the workspace. Hold down the left
mouse button when the cursor is above the splitter, and move the mouse left or right to resize the BitZipper Explorer and workspace.



Workspace

When you open an archive, the content will be displayed here. If you open several archives simultaneously, you can switch between
the archives by clicking on the tabs that will appear at the bottom of this area.



Toolbar

The toolbar contains shortcuts to the most common actions you perform in BitZipper. Click one of the buttons on the toolbar to begin
the task the button describes.

If buttons are disabled (dimmed) it means that the action cannot be performed given the current conditions. E.g. you cannot click
Add when no archive is open, or Install when no setup.exe is present in the archive.

You can disable the toolbar from the Preferences menu.






Registration reminder
BitZipper is not free. You are entitled to 30 free runs to evaluate the program, and you have used them all. Click the Order button

to display information on how to obtain a license code that will remove this reminder message. You can continue using the program,
the only difference is this reminder screen when you close the program.



OK button
This button will display a countdown in the "penalty period", and afterwards be changed to an OK button you can click to leave the
program.



Order button
Clicking this button will display information on how to obtain a BitZipper license code which is necessary if you want to continue
using the program legally.



Credit card image
Clicking this image will start your web browser and display the Order and Pricing page on our web server. You can order your
license online and have it delivered by email within 48 hours.






Register

BitZipper is not free. You are entitled to 30 test runs of the program, but after that you must buy the program to continue using it. The
program will continue working after the 30 runs, but a registration reminder screen will be displayed when you stop the program.

If you have paid the registration fee and received your registration code, enter the name and registration code in the two input fields
exactly as written in your order confirmation and press the OK button. A message will tell you if the code was accepted.

When a correct code has been entered, the "Buy now" icon on the main screen will be removed, and the registration reminder
screen that appears when quitting the program after the 30 day evaluation has expired will no longer appear.



Name

Enter the name exactly as written in your order confirmation. You cannot change the spelling of the name or use another name.



Code

Enter the registration code exactly as written in your order confirmation.






Search files in archive

In this window you are able to search for text or numeric sequences in files within the archive. Use this feature to locate files by
keywords if you have forgotten the filename.

Your keywords can be entered as Ascii (normal text), Decimal numbers, hexadecimal numbers or octal numbers.



Search button

Click this button to start searching for the text or numeric values entered above. The result will be displayed in the list above this
button.



Close button

Click this button to return to the main menu. Any selected files in the search result list will be highlighted on the main screen for easy
processing. To e.g. view a file, select it and click close. You can then view it from the main screen by pressing the View icon on the

toolbar.



Text to find

Enter the text you wish to search for. If searching for anything else than Ascii (normal) characters, separate each number with a
space, e.g. for hex "01 02 03 04 05 06 07 08 09 Oa Ob Oc 0d Oe Of".



Files to search

Specify the files you wish to search within the archive by entering a filename. Wildcards are ofcourse supported so you can search
multiple files. Enter *.* to search all files.



Search type

Choose if you want to search for an Ascii string (normal text), a decimal number sequence, a hexadecimal number sequence or an
octal number sequence.



Search options

This group of options lets you choose if you only want to find the first match in each file and if you want the search to be case
sensitive (case sensitive means that uppercase letters are treated differently from lowercase letters, e.g. B is not equal to b) or not.



Find only first match

Check this option if you only want to find the first match in each file. If unchecked, all matches will be displayed in the result list.



Case sensitive search

Check this option to enable case sensitivity. That a search is case sensitive means that the program will treat uppercase and
lowercase characters as being different, e.g. b is not equal to B. Uncheck this option if case is not important.



Search result

The result of your search will be displayed in this list. You may select files in the list and either double-click them or click the Close
button, and the files will be highlighted in the archive content list, ready for whatever action you want to perform on them.






New file window

In this window you are able to select the location and name of your new archive. You can browse your system for the folder you wish
to store your archive in, using the folder selector and folder tree in the left side of the window, just like in Windows Explorer. Select
the folder, enter a filename and hit the OK button. You may also enter a filename including path directly in the Save as input field.

The type of archive created depends on the file extension you add to the filename. If no extension is entered, .zip is added
automatically.

Supported archive formats and extensions
.bh - BlakHole

.cab - Microsoft Cabinet

.gz - Unix GZ (gz/tar)

jar - JavaSoft archive

.Iha - LHA archive

Izh - LZH archive

.tar - Unix tape archive

.zip - Zip archive



OK button

Click the OK button to use the new filename you have entered. This button will be disabled if no filename is entered.



Cancel button

Click this button to abort the filename selection operation and return to the main window.



Drive selector

Select a drive, virtual or physical, from this selector, and the content will be displayed in the tree- and list views below.



Display parent folder

Press this button to display the content of the parent folder. This is the same as clicking the folder above the current folder in the
tree above.



Create new folder

Click this button to create a new folder. Enter the name of the new folder in the input field that appears and press Enter to create
your new folder.



Display folder tree

Click this button to display/hide the folder tree to the left of the folder content list. The folder tree is used for easy browsing of drives
and folders.



Display small icons

Click this button to display the files in the selected folder as small icons.



Display file details

Click this button to display detailed information about the files in the selected folder. Filename, size, type and date of last
modification is showed.

A header will be displayed above the files in the folder content window. Click on one of the column headers to sort the files by name,
size, type or modification date.



Tree and list splitter

A splitter is an item that splits a window in two. It is a thin line between the folder tree and folder content list. Hold down the left
mouse button when the cursor is above the splitter, and move the mouse left or right to resize the two splitter panes.



Drive structure

This window displays the layout of folders on your system as a tree. Click on the small + signs to display sub-folders. Clicking on a
folder name will display the files in the folder in the list to the right of this window.



Folder content list

This window contains a list of files in the selected folder.



Save as

Enter the name you wish to give your new archive. If you do not enter a path in the filename, the selected folder in the tree or list
above will be used. You may also enter a filename including path directly in this input field.

The type of archive created depends on the file extension you add to the filename. If no extension is entered, .zip is added
automatically.

Supported archive formats and extensions
.bh - BlakHole

.cab - Microsoft Cabinet

.gz - Unix GZ (gz/tar)

.jar - JavaSoft archive

.Iha - LHA archive

Izh - LZH archive

.tar - Unix tape archive

.zip - Zip archive



Show Add dialog

Check this option to automatically display the Add files window. Saves time if you want to add files to your new archive immediately
after closing this window.



File types

This option is used to limit the number of files displayed in the file list above. Select which file types you want to display in the list in
this selector. Default is all supported archive types + .exe files. Executable files are included as they may be self extracting archives
which the program can open. If however you try to open an exe file that is not a self extracting archive, you will get an error

message telling you the file cannot be opened.



Select folder window

In this window you are able to select the archive location. You can browse your system for the folder you wish to store your archive
in, using the folder selector and folder tree in the left side of the window, just like in Windows Explorer. Select the folder and hit the
OK button. You may also enter a folder directly in the Folder input field.



OK button

Click the OK button to use the folder you have selected. This button will be disabled if no folder is selected.



Folder

Enter the name of the folder you wish to use. If you do not enter a folder, the selected folder in the drive selector, the tree or the list
above will be used.



Open archive window

In this window you are able to open an existing archive. You can browse your system for the folder where your archive is stored
using the folder selector and folder tree in the left side of the window, just like in Windows Explorer. Select the archive file and hit the
OK button to open it. You may also enter an archive name directly in the Filename input field.



OK button

Click the OK button to open the archive you have selected. This button will be disabled if no archive is selected.



Filename

Enter the name of the archive you wish to open. If no folder information is entered as part of the filename, the file is assumed to be
placed in the folder you have selected in the folder tree or list above.






UUEncode window

In this window you are able to uuencode an archive. By uuencoding an archive you convert it to text format, which can be used to
transfer the archive over medias that do not support binary data. Formerly you had to uuencode files to attach them to emails, but
most of todays email software handle this automatically.



Save as

Enter the name of your encoded file(s). An extension will be added automatically if you do not supply one - the default is .uue



Browse for folder

Click this button to browse your system for a folder with an Windows Explorer-like interface.



Encoding method

This group of options lets you choose the encoding algorithm to use. Select between uuencode or xxencode. uuencode is the most
widely used algorithm, and xxencode is a newer optimised version of the same algorithm.



uuencode

uuencode is the most commonly used algorithm of its kind. For the technically interested it works by transforming a binary file into a
printable text file by splitting the file up into groups of 3 bytes (24 bits), which is then split into 4 6-bit values. Each 6-bit value is
incremented by 32 which maps the values onto the printable Ascii values. This results in converting every 3 binary characters into 4
printable characters.



xxencode

xxencode is an enhanced version of the uuencode algorithm. For the technically interested uuencode works by transforming a
binary file into a printable text file by splitting the file up into groups of 3 bytes (24 bits), which is then split into 4 6-bit values. Each 6-
bit value is incremented by 32 which maps the values onto the printable Ascii values. This results in converting every 3 binary

characters into 4 printable characters. xxencode modified uuencode to have the 6-bit values (0, 1, 2, 3 .. 63) mapped 1-to-1 into the
printable characters.



KB per file

Enter the number of kilobytes (KB) you want to store in each file encoded file. Several files may be generated for a single archive,
similar to archives spanning more disks.



OK button

Click this button to encode the archive.



Cancel button

Click this button to return to the main screen without encoding the archive.






The BitZipper Wizard

The BitZipper Wizard is a set of simple interfaces for carrying out the most common archiving operations. A Wizard is a helper

application within the program that consists of a series of windows. On each window you have to perform a single easy task, and
press the Next button to proceed to the next window.



Back button

Click this button to return to the previous window. Use it to back and change previous selections. This button will be disabled there is
no previous window.



Next button

Click this button to proceed to the next window. This button will only be activated when you have filled all required fields in the
current window.



Close button

Click this button to return to the main window without performing any action.



Choose Wizard
Choose the wizard you want to use by checking an option and clicking the Next button.

Options

® Create new archive

® Extract or install files from an existing archive
® Create backup set

® Backup files using existing backup set



Select archive to extract files from

This Wizard allows you to extract files from an existing archive. Enter the name of the archive in the input field, or click the [...]
button to browse your system for the archive. When ready, click the Next button to proceed to the next step.



Select destination

On this window you must select where to store the files in the archive when extracting them. Enter a folder in the input field or
browse for one by clicking the [...] button.

Check the "Explorer files after extracting" checkbox if you want the Microsoft Explorer to pop up after extracting the files.
Check the "Run setup program and clean up after extracting" to run the setup program within the archive when all files have been

extracted. The temporary files will be cleaned up when the setup program finishes. This option is only enabled if a setup.exe file
exists in the archive.



Save in

Select the folder in which you want to store the extracted files from the archive. Either enter a folder in the input field or browse for
one by clicking the [...] button.



Explore files after extracting

Check this option if you want the Microsoft Explorer to pop up after extracting the files, letting you browse the files you just
extracted.



Run setup program

Check this option to run the setup program within the archive when all files have been extracted. The temporary files will be cleaned
up when the setup program finishes. This option is only enabled if a setup.exe file exists in the archive.



Files extracted successfully

Congratulations! The files have been extracted successfully. Click the Close button to return to the main window.



Select a name for your new archive

This Wizard allows you to create a new archive and add files to it. Enter a name for your new archive in the input field, or click the
[...] button to browse your system for a folder to store it in. When ready, click the Next button to proceed to the next step.



Select files to include in your archive

On this window you may add files to your new archive. You can add files by dragging them from the Windows Explorer and dropping
them on the file list in this window, or you can click the Add button to browse your system for files to add.

If you wish to remove some of the files selected for inclusion, click them in the list and hit the Remove button.



List of files to add

This list contains the files you have selected for inclusing in your new archive. If you regret adding some of them, select them in the
list and click the Remove button to remove them again.



Add button

Click this button to display a Windows Explorer-like window where you can browse your system for files you want to add to your new
archive.



Remove button

Click this button to remove the selected files from the list of files to add to the archive.



Archive created successfully

Congratulations! The files have been successfully added to your new archive. Click the Close button to return to the main window.



Select hame for your new backup set

This Wizard helps you configure backup sets. Enter the name in the input field and click the Next button to proceed to the next step.
One of the unique features of this archiving program is the possibility to use backup sets. A backup set is a simple way of performing
the same backups several times. You select the files to add as you would when creating a normal archive. This archive "template" is
stored in the configuration, and can be reused over and over again.

Do you backup your files on a regular basis?

No? - with backup sets there are no longer any bad excuses. When created, you can backup your files simply by clicking the
Backup button on the toolbar, selecting the backup set and entering the name of your backup. That's all there is to it!



Select files to include in your backup set

On this window you may add files to your new backup set. You can add files by dragging them from the Windows Explorer and
dropping them on the file list in this window, or you can click the Add button to browse your system for files to add.

If you wish to remove some of the files selected for inclusion, click them in the list and hit the Remove button.



List of files to include

This list contains the files you have selected for inclusing in your new backup set. If you regret adding some of them, select them in
the list and click the Remove button to remove them again.



Add button

Click this button to display a Windows Explorer-like window where you can browse your system for files you want to add to your new
backup set.



Remove button

Click this button to remove the selected files from the list of files to include in the backup set.



Backup set created successfully

Congratulations! Your new backup set has been successfully created. Click the Close button to return to the main window.



Create backup

This Wizard helps you create a backup using an already configured backup set. By performing two simple tasks you will have
created a backup. The first task is to select the backup set to use from the dropdown menu on this window. Select one and click the
Next button to proceed to the next task.



Select a name for your new backup

Enter a name for your new archive in the input field, or click the [...] button to browse your system for a folder to store it in. When
ready, click the Next button to create your backup.



Backup created successfully

Congratulations! The files specified in your backup set have been successfully added to your new archive. Click the Close button to
return to the main window.






About BitZipper

This window contains general information about BitZipper such as version number, registration information, contact addresses and
copyright notice. This window is informational only.



www.bitberry.com

Click this text to start your web browser and display the Bitberry Software site.



support@bitberry.com

Click this text to start your default mail software and write an e-mail to Bitberry Software support.






General Add options

This tab contains the general options available when adding files to an archive. Click on ? again and point the arrow on any items on
the tab to get additional help.



Add files

In this window you add files to an archive. Browse for files like you do in the Windows Explorer by using the Drive Selector, Folder
Tree and Folder Content list.

Tips

® Select a folder and click Add to add all files in a folder

® Use ctrl and shift keys with space or mouse buttons to add specific files
® Enter a filespec, e.g. *.doc, to add multiple files



Display drive structure

Click this button to display/hide the folder structure of the current drive. The folders are displayed in a tree where you can click the +
and - signs to expand/collapse specific folders.



Files options

This group of options decide how many files are added to the archive. Click ? again and point on one of the options to get additional
help.



Add selected files

Check this selector to add the files highlighted in the folder content list above.



Add all files

Check this selector to add all files in the highlighted folder in the folder tree above.



Add specific files

Check this selector and enter a filename or filespec, e.g. *.doc, to add specific files to the archive.



Folders options

This group of options specifies how folders are treated when you add files from sub-folders to an archive. Click ? again and point it
on any of the options to get additional help.



Include files in subfolders

Check this option if you want to add files in subfolders matching your entered or selected filename or filespec to the archive. If not
checked, only files in the selected folder will be added.



Include folder information

Check this option to store folder information for the files that you add to the archive. Also see the Include drive information and
Relative folder options.



Include drive information

Check this option to store drive information for the files that you add to the archive. Beware that files will be extracted to the same
drive letter when you try to extract the files again. Normally you do not need to use this option.



Relative folders

Check this option to store relative folder information for the files that you add to the archive. This option is only used when “Include
folder information” is checked. Normally you would check this option to allow the receiver of your archive to create the same folder
structure under any folder he choses.

Example
Assume you are backing up files from the "work" folder of the c:\documents\work path. With this option checked, only the "work" part
of the path is stored. If not checked, the full (absolute) path "\documents\work" is stored.



Compression level

This dropdown box enables you to specify the compression level to use when adding files to the archive. Chose between maximum,
normal, light or none.



Add button

Click this button to add the selected files to the archive. This button is only enabled if a valid selection has been made.



Cancel button

Click this button to cancel the add operation. No files will be added to the archive.



Advanced files options

This group of options decide how files are treated after they have been added to the archive. Click ? again and point on one of the
options to get additional help.



Delete files after adding

Check this option to delete the files from the harddrive after they have been added to the archive. Be careful when using this option.



Attributes options

This group of options decide how many files are treated based on their attributes. File attributes contain information about write-
permissions, archival status etc. If you don't know about these attributes you do not need these options as they are normally not
used.



Only add if archive bit set

If you check this option, only files with the archive attribute set will be added to the archive.



Clear archive bit after adding

Check this option to clear the archive attribute for all files after they have been successfully added to the archive.



Password

Enter a password to encrypt the archive content. When you want to extract files from the archive again you must specify the same
password.



Exclude files

This list contains filenames and filespecs that you do not want to add to your archive. Use this option to avoid adding text backup
files, log files and any other temporary files to your archives.



Exclude files, Add

Press this button to enter a filename or filespec to add to the list of files you do not want to add to your archives.



Exclude files, Delete

Press this button to remove the selected filenames from the list of files you do not want to add to your archives. Before pressing the
button you must select one or more filenames from the list above.



Advanced Add options

This tab contains the advanced options available when adding files to an archive. Click on ? again and point the arrow on any items
on the tab to get additional help.



Display parent folder

Press this button to display the content of the parent folder. This is the same as clicking the folder above the current folder in the
tree below.



Store in folder
Fill in this field if you want to store the files in a specific folder in the archive.

Example: If you have selected the file a.txt it will by default be stored in the 'root' of the archive. If you enter MyFolder in the "Store in
folder" input field, the file will be stored as MyFolder\a.txt.



Repeat password

Because password protected archives cannot easily be restored, you must enter the same password again to make sure that there
are no spelling errors etc.



Passwords

You may protect your archive with a password. When you wish to extract files from the archive you must enter the same password.
You are required to enter the same password twice to make sure that the correct password has been entered.



Leave space on first disk

When creating archives spanning multiple floppy disks, it is sometimes needed to store some uncompressed data on the first floppy,
e.g. a readme.txt file with installation information. Enter the number of kilobytes (1 kilobyte is 1024 bytes) to reserve on the first

floppy.






Select backup set

Select the backup set you wish to use from the Backup set dropdown list. To create additional backup sets use the Edit, Preferences
menu.



Select backup name

Enter the name of the backup archive. You may select archive type by adding the appropriate extension to the filename, e.g. .cab to
create Cabinet files. Default archive type is zip.



Browse for destination folder

Click this button to open an Explorer-like window where you may browse for your destination folder, that is the folder in which you
want to store your archive.



Backup a set of files

Backing up a pre-defined set of files has never been easier. Simply chose your backup set, enter a backup name and press the
Backup button. That's all there is to it!



Backup button

Click this button to perform your backup when you have selected a backup set and an archive name.



Cancel button

Click this button to return to the main window without performing a backup. No archive will be created.



Password

You may enter a password to protect your backup archive. When you need to restore files from the archive, the same password
must be entered.






Damaged archive

You see this message when an error is detected in the archive while reading it. Information about which structure in the archive is
damaged is displayed for your information only. If you have transferred the file from the Internet, try downloading it again. If you
have used ftp to download it, make sure that you set transfer mode to binary before trying again. Click the Yes button to try to read
the archive anyway - BitZipper has build-in recovery functions that recover some types of damages.



Try to recover damaged archive

Click this button to try to read the damaged archive and let BitZipper try to perform recovery on the archive. If the operation
succeeds, you should extract all files and create a new archive.



Skip damaged archive

Click this button to cancel the opening of the damaged archive.






Delete files

To delete files from the archive, select which files to delete and press the Delete button.

Options

® Selected files deletes only highlighted files

® All files deletes the entire archive

® Files lets you enter a filename or filespec to delete

Press the Delete button to delete the files or the Cancel button to return to the main window without deleting any files.






Enter filename

In this window you can enter a filename. Depending on the operation you are currently performing, you can also use wildcards like ?
and *. Wildcards cannot be used if you are entering a new filename for a renamed file, but may be entered when entering filenames

for exclusion in archive operations.



OK button

Click the OK button to use the new filename you have entered. The button is disabled until you enter a filename.



Cancel button

Click the Cancel button to stop the operation requirering a new filename.






Export

In this window you are able to generate a file list containing information about the files contained in the open archive. The
information written for each file is the same as you see on the screen. You can export your file list in several formats, including Ascii
(text), comma separated text, HTML, Microsoft Excel format, Microsoft Word format and XML.



Filename

Enter the name of the file you wish to create. If you do not enter a file extension, one will be added depending on the output format
you chose.



Separator

Enter a separator used to separate the information stored for each file when generating ASCIl and Comma separated files. The
default separator is a comma.



To

Chose the format you wish to use when creating your file list. Possible formats are Ascii, comma separated, HTML, Microsoft Excel,
Microsoft Word and XML.



HTML settings

You are able to customise the HTML output by adjusting the parameters in the HTML settings section. If none are provided, default
values will apply.



Border size

This parameter sets the border size of the generated HTML table by adjusting the "border=" setting for the table.



Cell spacing

This parameter sets the cell spacing of the generated HTML table by adjusting the “cellspacing=" setting for the table.



Prefix tag

This parameter sets optional HTML tags before the grid content HTML code (the table itself). Use it to apply e.g. a custom header
above the table.



Postfix tag

This parameter sets optional HTML tags after the grid content HTML code (the table itself). Use it to apply e.g. a custom footer
below the table.



Width

This parameter sets the width in % of the HTML table by adjusting the "width=" setting for the table.



OK button

Click this button to generate a file specified by the filename above. If no name has been entered this button will be disabled.



Cancel button

Click this button to return to the main menu without generating a file list.






Drive selector

Select a drive, virtual or physical, from this selector, and the content will be displayed in the treeview below.



New folder

Click this button to create a new folder. Enter the name of the new folder in the input field that appears in the treeview below and
press Enter to create your new folder.



Drive structure

This window displays the layout of folders on your system as a tree. Click on the small + signs to display sub-folders. Clicking on the
folder name you wish to extract your files to.



Direct path

Enter the path you wish to extract your files to here, or select one of the 5 most recently used paths from the drop down menu. This
option allows you to skip browsing through folders using the tree above if you know the exact path.



Files options

This group of options allows you to chose which files are extracted.

Options

Selected files extracts only the files highlighted in the archive content list

All files in selected folder extracts all files in the folder selected in the archive folder tree
All files in archive extracts all files in the archive

Files extracts files matching the filename/filespec you enter



Selected files

Clicking this options will extract only the files that you have highlighted.



All files in archive

Clicking this option will extract all files in the archive.



Files

Clicking this option requires you to enter a filename (? and * wildcards are allowed). Only files matching the filename will be
extracted.



Options

This group of options allows you to chose the overwrite policy, decide whether original file attributes should be set after extraction,
have the same folder tree created as stored in the archive and finally decide if you want to open the Windows Explorer for browsing
of the extracted files.



Overwrite
This dropdown menu allows you to chose the behaviour of the program if it tries to extract a file that already exists on the harddrive.

Options

® Prompt before overwriting - always ask

Always overwrite - will always replace the file on the harddrive

Never overwrite - will never replace the file on the harddrive

If newer - replaces if the file in the archive is newer than the one on the harddrive
If older - replaces if the file in the archive is older than the one on the harddrive



Set original attributes

Click this option to restore the file attributes the files had on the system where the archive was created.



Create original folders

Click this option to create the same folder structure as on the system where the archive was created. This is recommended.



Explore files after extracting

Clicking this option will bring up the Windows Explorer after extracting the files, allowing you to browse your new files.



Extract window

In this window you are able to extract files from an archive. Chose where you want to store your new files, optionally set a few
extraction options and click the Extract button. That's all there is to it.



Extract button

Click this button to extract the selected files to the selected folder.



Cancel button

Clicking this button will cancel the extract operation and return to the main menu. No files will be extracted.



All files in selected folder

Clicking this option will extract all files in the folder selected in the archive folder tree.






Progress

This window shows the progress of the current operation. The upper progress bar displays the current file status, and the lower
progress bar displays the status for the total operation. The progress bars displays the percentage done. You may click Cancel to
abort the current operation.






Enter password

One or more files in the archive are password protected. Enter the password used when creating the archive. The same password
will be tried for other password protected files in the archive. If it does not match the password used at the time of creation, you will

be prompted for another.






Overwrite window

A file with the same name already exists and you have the option to replace the file with the new file.

Options
Yes - Overwrites the file
® Yes to all - Overwrites the file and all other dublicate files
® No - Does not overwrite the file
® No to all - Never overwrites any files (does not ask you again)



Original file

This is the file that already exists.



New file

This is the file that will replace the existing file if you chose to overwrite it.






BitZipper explorer

The build-in explorer-like interface is added to provide a shortcut to opening files. It is no longer necessary to press Open and select
a file, now you can simply select the file directly from the filelist on the main screen.

Just as the Windows explorer, the BitZipper Explorer is build up of a drive selector, folder tree view and a file list. The explorer can
be disabled either from the View menu or by clicking the x icon in the upper right corner, right beside the drive selector.



Display small icons

Click this button to display the files in the selected folder as small icons.



Display file details

Click this button to display detailed information about the files in the selected folder. Filename, size, type and date of last
modification is showed.

A header will be displayed above the files in the folder content window. Click on one of the column headers to sort the files by name,
size, type or modification date.



Close BitZipper explorer

Click this button to disable the BitZipper Explorer. You can re-open the explorer window from the View menu.






BitZipper
This is the main window of BitZipper from Bitberry Software.
BitZipper aims at being the most comprehensive archiving tool on the market. It features many functions needed in your daily work

with archives that you do not find in any other archiving tool on the market today. These features range from the user friendly
interface, comprehensive online help, archive tree view, backup sets, support for all common archive formats and much much more.



Status bar

The status bar contains information about the task just performed, e.g. how many files the just opened archive contains, how many
files were added to an archive etc.






Archive tree splitter

A splitter is an item that splits a window in two. It is a thin line between the archive tree and content list. Hold down the left mouse
button when the cursor is above the splitter, and move the mouse left or right to resize the two splitter panes.



Display archive tree

Press this button to display/hide the folder structure of the files in the archive. When opening an archive, the archive tree is
automatically displayed if the archive contains folder information for the files.



Archive tree

This window displays the layout of folders in the archive as a tree. Click on the small + signs to display sub-folders. Clicking on a
folder name will display the files in the folder in the list to the right of this window.



Archive content list

The archive content list is a list of files in the archive. As default all files are displayed, but by enabling the Archive Tree you can
decide to view files from a single folder only.

It is fully configurable what information should be displayed for the files. As default, filename, uncompressed size, compressed size,
compression ratio, date of modification and path is displayed for each file. Through the Edit, Preferences menu you can configure
the information to be displayed.

Tips
BitZipper offers several Windows Explorer-like functionalities:

Double-click a file to execute it
To select multiple files, use ctrl and shift key with space or mouse click
Drag file(s) to a folder or the desktop to uncompress

L]
L]
L]
® Right-click a file to display a popup menu with most common actions



Archive comment

The archive comment is a description of the archive content added by the archive creator. BitZipper will automatically display the
comment when opening the archive.



Comment splitter

A splitter is an item that splits a window in two. It is a thin line between the content list and archive comment. Hold down the left
mouse button when the cursor is above the splitter, and move the mouse up or down to resize the two splitter panes.



Display small icons

Click this button to display the files in the archive as small icons.



Display file details

Click this button to display detailed information about the files in the archive. By default filename, uncompressed size, compressed
size, compression ratio, modification date and file path is displayed. You can configure what information to display from the Edit,
Preferences menu.

A header will be displayed above the files in the archive content window. Click on one of the column headers to sort the files by
name, size, modification date etc.



Display file comment

Click this button to display/hide the comment associated with the archive.



Current archive

This window contains information about the current archive. Buttons to display archive tree, archive comment and files are in the
upper-left corner. Button to close the current file is in the upper-right corner. Below is (optionally) a tree showing the folder structure
of the archive, the files themselves and below is (optionally) the archive comment.

Click ? and point on any of the above mentioned items to get additional help.



Close archive

Click this button to close the current archive.



Archive content list header

Click any of the column names to sort the archive content by the values of that column.






Preferences window

The preferences window is where you can customise the program with your individual settings. You can to some extent change
layout and behaviour of the program. Browse through the options by clicking the entries in the tree to the left - clicking the small +
signs expands the options and shows the sub options.



General settings

This window contains the general settings for the program appearance. You can configure the look and behaviour of the file list on
the main window, select to display the build-in explorer and chose to have the program beep when long archive operations have
been performed.



Show grid lines

Check this option if you want each file in the content list to be separated by a thin line.



Full row select

Check this option if you want to be able to select a file in the content list by clicking on any information related to that file like
filename, size, date of modification etc. If un-checked you can only select a file by clicking on the filename.



View navigation window

Check this option to display the navigation window in the left part of the main screen. The navigation window allows you to open zip
files by dragging files from the left part of the screen onto the workspace, without going through the File Open screen. See the
navigation window as beeing a build-in Windows Explorer - the functionality is exactly the same.



Beep after long operations

Check this option to have the program beep after long archiving operations.



Content list

In this window you are able to configure which information you want to display for each file in an archive in the content list. The left
list contains available columns, while the right list contains already selected columns.



Available columns

This list contains values you are able to display for each file in the archive content list. Add a value by selecting it with a single
mouse click, and clicking the Add button, or simply drag the value from the left list to the right.



Add button

Click this button to add the selected values in the left list to the right list. The columns will be displayed in the archive content list.



Remove button

Click this button to remove the selected values from the right list. The columns will no longer be displayed in the archive content list.



Up button

Click this button to move up the selected items in the right list. The item position influences the display order in the archive content
list - the display order is from top to bottom, which equals from left to right in the archive content list.



Down button

Click this button to move down the selected items in the right list. The item position influences the display order in the archive
content list - the display order is from top to bottom, which equals from left to right in the archive content list.



Columns in use

This list contains values already configured to be displayed in the archive content list. Remove a value by selecting it with a single
mouse click, and clicking the Remove button, or simply drag the value from the right list to the left.



Toolbar

In this window you are able to configure which buttons you want to display on the toolbar on the main window. The toolbar is located
just below the menu and is used as a shortcut to the most common operations.



Available buttons

This list contains buttons you are able to display on the toolbar. Add a button by selecting it with a single mouse click, and clicking
the Add button, or simply drag the value from the left list to the right.



Add button

Click this button to add the selected button in the left list to the right list. The buttons will be displayed on the toolbar.



Remove button

Click this button to remove the selected buttons from the right list. The buttons will no longer be displayed on the toolbar.



Up button

Click this button to move up the selected items in the right list. The item position influences the display order on the toolbar - the
display order is from top to bottom, which equals from left to right on the toolbar.



Down button

Click this button to move down the selected items in the right list. The item position influences the display order on the toolbar - the
display order is from top to bottom, which equals from left to right on the toolbar.



Buttons in use

This list contains buttons already configured to be displayed on the toolbar. Remove a value by selecting it with a single mouse click,
and clicking the Remove button, or simply drag the value from the right list to the left.



Button settings

This group of options allows you to configure the layout of the toolbar. Chose between flat and 3d buttons and text on/off.



Flat buttons

Check this option if you want to display the icons on the toolbar in a flat style. The style is similar to the one in Microsoft Internet
Explorer. Flat buttons do not have a visible edge before moving the mouse cursor over it. If unchecked, the buttons will be in classic

3d layout.



Show button text

Check this option to display a text below the button image on the toolbar.



Folders

In this window you are able to configure which folders to use in open, add and extract operations. You can specify either a static
folder or chose to use the folder used last time the operation was performed.



Open folder

This group of options lets you configure the folder to use when opening an archive.



Last open folder

Check this option to use the same folder as used in the previous open operation.



Static open folder

Check this option to always use the same folder when opening archives. Enter the folder name to the right, or press the "..." button
to browse for the folder.



Static folder

Enter the name of an existing folder you wish to use for the operation every time, or click the "..." button to the right of the input field
to browse your system for the folder.



Browse for folder

Click this button to browse your system for a folder using a Windows Explorer-like interface.



Add folder

This group of options lets you configure the folder to use when adding files to an archive.



Last add folder

Check this option to use the same folder as used in the previous add operation.



Static add folder

Check this option to always use the same folder when adding files to an archive. Enter the folder name to the right, or press the "..."
button to browse for the folder.



Extract folder

This group of options lets you configure the folder to use when extracting files from an archive.



Last extract folder

Check this option to use the same folder as used in the previous extract operation.



Static extract folder

Check this option to always use the same folder when extracting files from an archive. Enter the folder name to the right, or press
the "..." button to browse for the folder.



System settings

In this window you are able to configure various system settings such as where you want shortcuts created to this program, and
whether you want to enable quick access to the program by extending the functionality of the Windows Shell (Windows Explorer).



Icons

This group of options lets you configure where you want to create shortcuts for this program.



Start menu icon

Check this option to add a shortcut to this program til the Windows Start menu.



Desktop icon

Check this option to create a shortcut to this program on the desktop.



Windows Explorer

This group of options lets you configure if you want to enable shortcuts from the Windows Explorer to the most common operations
(add, extract and create SFX).



Shell extensions

Check this option to enable shell extensions. When right-clicking files in the Windows Explorer you will be given a range of options
to create archives, extract archive content, convert archive to a self-extracting archive or compress and mail an archive. This means
that you with a single click of a button can create an archive and e-mail it! It's really that simple.



Associations

In this window you are able to configure which archive types will be associated with BitZipper. Associating an archive type with
BitZipper will extend the functionality of the Windows Explorer. When double-clicking an archive of an associated type will bring up
BitZipper that will show the content of the archive. It is recommended that you associate all archive types with BitZipper to get the
most out of the program. To do so, simply check all options in this window.

Access the content of any of the 16 supported archive types simply by double-clicking files in the Windows Explorer.



Favourite folders

In this window you are able to configure your favourite folders. These folders may be used on copy and move operations. The most
common use of this feature is to create a folder structure like the one below, and use it for keeping order of downloaded files.

Example
c:\download\Misc
c:\download\Games
c:\download\Utilities
c:\download\Pictures



Favourite folders list

This list contains the already configured favourite folders. You can change the order of the folders by using the buttons to the right.
The order of the folders will be reflected in the Copy and Move menues, so you should place the most used folders at the top of the

list.



Up button

Click this button to move the selected folders upwards in the list. The order of the folders will be reflected in the Copy and Move
menues, so you should place the most used folders at the top of the list.



Down button

Click this button to move the selected folders downwards in the list. The order of the folders will be reflected in the Copy and Move
menues, so you should place the least used folders at the bottom of the list.



Remove button

Click this button to remove the selected folders from the list.



New folder

Enter the name of a folder you want to add to the list of favourite folders, or click the "..." button to browse your system for the folder.
After entering the name, click the Add button.



Add button

Click this button to add the folder you entered or selected to the list of favourite folders. You may change the order of the folders by
selecting a folder and using the Up and Down buttons. The order of the folders will be reflected in the Copy and Move menues, so
the most used folders should be placed at the top.



Backup sets
In this window you are able to configure backup sets. One of the unique features of this archiving program is the possibility to use

backup sets. A backup set is a simple way of performing the same backups several times. You select the files to add as you would
when creating a normal archive. This archive "template" is stored in the configuration, and can be reused over and over again.

Do you backup your files on a regular basis?

No? - with backup sets there are no longer any bad excuses. When created, you can backup your files simply by clicking an icon on
the desktop - that's all there is to it!



Select backup set

Select an existing backup set by opening the dropdown menu, or simply enter the name of a new backup set.



Backup destination folder

Enter the name of a folder you want to use as default folder when performing backups using this backup set. You are able to change
the folder when backing up, this folder is just entered to speed up the backup process.



Save full path info

Check this option if you want store full path information in the archive. If not checked, only the parent subfolder is stored. If you for
example add:

c:\MyFiles\Documents\*.*

With full path info, "\MyFiles\Documents\<filename>" is stored. Without full path info, "Documents\<filename>" is stored.



Backup set files

This group of options all relate to the files to be backed up when using this backup set. Configure the filenames/filespecs using the
Add and Remove buttons or simply drag files or folders onto the list.

The Recurse column indicates whether files in subfolders are included or not. You can change the setting by double-clicking a row in
the list.



Backup set content

This list contains the files already configured to be part of the backup set. Click the Add button to add more files. You may select files
by clicking on them in the list, and press the Remove button to remove them from the backup set.



Add button

Click this button to enter a name of a file or folder you want to add to the list of files you want to backup when using this backup set.



Remove button

Click this button to remove the selected files or folders from the list of files contained in this backup set.



OK button

Click this button to save the current backup set configuration.



Remove button

Click this button to remove the current backup set.



New button

Click this button to clear the input fields of the backup set screen so that you are ready to add a new backup set. No data will be
removed from the configuration database when you click this button, only the screen content will be cleared.



Options tree

Browse through the options by clicking the entries in the tree to the left - clicking the small + signs expands the options and shows
the sub options. When selecting an option in the tree, the configuration screen will be displayed to the right.



Default button
Click this button to restore the standard configuration of the program.

Warning: Your own settings will be lost.



Save button

Click this button to save your configuration changes.



Cancel button

Click this button if you do not want to save your configuration changes.



Apply button

Click this button to make your changes take effect immediately.



Locations of external applications

In this window you are able to specify the locations of external programs that BitZipper can use. You may specify the location of your
Anti Virus software and a file viewer.

BitZipper will try searching for your programs in the folders specified in the PATH environment variable, which contains a list of
commonly used folders. If unsuccessful, you must enter the program name including full path information to use it. That means,
instead of just entering e.g. viewer.exe, you must enter c:\program files\someviewer\viewer.exe



Anti-virus vendor

BitZipper suppors virtually all anti-virus packages, and comes pre-configured with settings for the most common virus scanners. If
you own one of the products you find in this drop down menu, simply select it and BitZipper already knows the configuration.

The Location field is filled with the name of the anti-virus program, and if the folder in which it was installed is included in the PATH
environment variable, it is ready for use. Otherwise click the [...] button to search for it, or enter the full filename including path
information.

The Parameters field is filled with the standard configuration already known by BitZipper.



Anti-virus location

If you select an anti-virus package from the Vendor drop down menu, this field is filled automatically. The program name must be
found in a folder included in the PATH environment variable, otherwise you must supply full path aswell. You may press the [...]
button to search for the program if you do not know the exact location.

You may also enter the location of an anti-virus package not supported by BitZipper by default, but make sure to fill in the
Parameters field with the correct values aswell.



Anti-virus parameters

If you select an anti-virus package from the Vendor drop down menu, this field is filled automatically. You must supply the
parameters passed to the anti-virus software package when BitZipper starts it. See in the manual of the anti-virus package which
command line parameters are available.

Use %p to indicate the path containing the files to be virus checked.



File viewer

You may specify the name of an external file viewer to be used when viewing files in archives. If you don't specify a program, the
program associated with type of file you want to view will be used.



Desktop icon

Click this button to add an Icon to the Desktop, pointing to this Backup Set. This enables you to activate the backup functionality
without starting BitZipper first.



Internet Explorer style

Check this option if you want the toolbar to be displayed in Internet Explorer style. If enabled, all icons will be gray except for the one
the mouse is currently moving over.



Skin file

You may customize the look of the toolbar by applying your own icons. Draw 34 icons of equal size and save them in one .bmp
(Windows bitmap) file. The icons must be organized in two rows of 17 icons each with no space between them. The order of the
images must be: New, Open, Add, Extract, View, Delete, Install, Close, Copy, Move, Wizard, Backup, Search, Convert, Virus scan,
Test and Batch.

Enter the name of a bitmap file, or press the [...] button to search your system.



Temporary folder

By default, temprary files are stored in the Windows temporary folder. If you of some reason want to store them somewhere else,
you may enter another folder name here, or press the [...] button to browse your system for another folder.



Desktop icon button

Click this button to create a shortcut to the Backup Set on the desktop. You can later click the icon on the Desktop to start backing
up your files.






Print content list

In this window you are able to print the archive content list. The information printed for each file is the same as the information
available in the archive content list on the screen. Changes to the screen layout will also be reflected on the printout.



OK button

Click this button to print the content list of the archive.



Cancel button

Click this button to return to the main screen without printing anything.



Options

This group of options lets you set various printing options like page orientation, if page content should be shrinked to fit the physical
page, if page content should be centered on the paper and if the header should be printed on the first page or on all pages.



Orientation

Select whether you want the page to be printed in portrait (“standing”) or landscape ("laying") layout. Use portrait if file information
fits a normal page, or use landscape to get wider lines.



Fit to page

Check this option if you want the page content to be shrinked to fit the page even though it would normally take up more space. Use
this option if you have very long lines and you do not want to truncate them.



Centered on page

Check this option to have the page content centered on the printed page unstead of having it left aligned.



Header on every page

Check this option to print a header on every page. If unchecked, the header will only be printed on the first page.



Time and date

This group of options lets you configure if date and time should be printed, where on the page they should be printed and in which
format.



Time

Select from the dropdown menu if you do not want to print the time, or if you want to print the time in the upper left corner, upper
right corner, centered at the top, bottom left corner, bottom right corner or centered at the bottom.



Date

Select from the dropdown menu if you do not want to print the date, or if you want to print the date in the upper left corner, upper
right corner, centered at the top, bottom left corner, bottom right corner or centered at the bottom.



Date format

Select from the dropdown menu which date format you want to use. This can be changed because dates are written differently e.g.
in the USA and in Europe.

Examples

dd/mm-yyyy - December 24, 2000 = 24/12-2000
mm/dd-yyyy - December 24, 2000 = 12/24-2000
yyyy-dd/mm - December 24, 2000 = 2000-24/12
yyyy-mm/dd - December 24, 2000 = 2000/12/24



Page number

This group of options lets you configure if page number should be printed, where on the page it should be printed and in which
format.



Page number location

Select from the dropdown menu if you do not want to print the page number, or if you want to print the page number in the upper left
corner, upper right corner, centered at the top, bottom left corner, bottom right corner or centered at the bottom.



Page number separator

The page number separator is a character used to separate the current page number from the total number of pages, 1/ 10.



Page number prefix

Here you may enter a text that is printed before the page number.



Page number postfix

Here you may enter a text that is printed after the page number.



Header

This group of options lets you specify a header to be printed on your page(s).



Title text

Enter the text you want to have printed at the top of your printed page(s). See also the Options section where you can specify
whether the header should be printed only on the first page or on all pages.



Header location

Select from the dropdown menu if you do not want to print the header, or if you want to print the header in the upper left corner,
upper right corner, centered at the top, bottom left corner, bottom right corner or centered at the bottom.






Program responsibilities changed

You will see this message when starting BitZipper if the program detects that other programs have modified the Windows
configuration in areas that affects BitZipper. BitZipper is associated with a configurable number of archive types, meaning that if you
double-click a file of such a type in the Windows Explorer, BitZipper will automatically start and display the archive content. Another
program has re-configured Windows so that program now will start instead of BitZipper.






BitZipper Batch Tool

In this window you are able to work with multiple archives. Select archives from the list below and press one of the icons above to
perform the same action on all selected archives.



BitZipper Batch Tool

Press this button to select all archives in the list below.



Deselect button

Press this button to deselect all archives in the list below.



Invert button

Press this button to inverse the selection in the list below. Selected archives will become deselected and vice versa.



Test button

Press this button to test all selected archives for errors.



Extract button

Press this button to extract all selected archives. You will be prompted where to store the decompressed files, and you can chose to
store them all in the same folder, or create a new folder per archive.



Virus button

Press this button to virus scan all files in the selected archives.



SFX button

Press this button to convert all selected archives to self-extracting archives (executable files).



Convert button

Press this button to convert all selected archives to another archive type.



Search button

Press this button to search all selected archives for specific content. You are able to search for text strings and decimal, octal and
hexadecimal sequences. The search function features a very powerful search engine like expression language.



Drive selector

Select a drive, virtual or physical, from this selector, and the content will be displayed in the tree- and list views below.



Drive structure

This window displays the layout of folders on your system as a tree. Click on the small + signs to display sub-folders. Clicking on a
folder name will display the files in the folder in the list to the right of this window.



Folder content list

This window contains a list of files in the selected folder. Click the little box to the left of the file name to select the file.



File types

This option is used to limit the number of files displayed in the file list above. Select which file types you want to display in the list in
this selector.



Result list

This list contains the status of the selected operation. Each line contains the name of the archive, which action as carried out, the
result and an optional comment. The comment will change depending on the action selected, e.g. the search function will display the
name of the file within the archive in which a match was found.






Installation defaults

In this window you specify the basic configuration of BitZipper, including the program language, which archive types to associate
with BitZipper, which icons to create and if BitZipper should add extensions to the Windows shell.



Select language

Please select your preferred language in the dropdown menu and press OK to continue.



Select archive types

Please select the archive types you want BitZipper to handle. Select the archive types by clicking the little box next to each line in
the list. If you don't know what to select, it is recommended that you select all archive types.



System settings

On this window you specify the basic system settings, such as where BitZipper is allowed to create icons and if BitZipper should add
extensions to the Windows shell (Windows Explorer). If you chose to use the BitZipper shell extensions you will be able to
compress, extract and email archives directly from the Windows Explorer without starting BitZipper.



Desktop shortcut

Check this option to create a BitZipper icon on your Desktop.



Start menu shortcut

Check this option to create a BitZipper icon in your Start menu.



Shell extensions

Check this option to add BitZipper extensions to your Windows shell (Windows Explorer). This enables you to compress, extract and
email archives directly from Windows Explorer without starting BitZipper first.






